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MAIL EXTRACTOR PLUS

USER GUIDE (version 4.1)
INTRODUCTION

Mail Extractor Plus is an order fulfillment and inventory management program for Amazon, Half.com, eBay, and Alibris sellers. Introduced in 2001, Mail Extractor was the first and only program created by an experienced bookseller for booksellers like you. It completely automates the process of:

- Inventory management (Amazon, Half, eBay Alibris)

- Importing orders from fulfillment report files and downloading from e-mails

- Creating and printing picking slips and invoices

- Postage printing (through DAZzle)

- Sending customized notification e-mails 

Mail Extractor Plus is highly customizable and offers many usefull features created as a result of many years of experience in online bookselling. It is very easy to use... should you have any questions we're here to help you along the way.

We recommend that you read carefully this USER GUIDE to give you a better idea on how to integrate Mail Extractor Plus with your business. Please read a very usefull section on how we use Mail Extractor Plus.
Mail Extractor automatically imports and processes orders from

   •    Amazon Order Fulfillment Reports for Marketplace (US and UK) and Merchant
   •    Half.com FTP files (Power Sellers)
   •    Half.com e-mails:  "You’ve Made a Sale"
   •    eBay-PayPal notification e-mails "Item #xxxxxxxxx – Notification of an instant....." 
   •    ebay File Exchange (Half.com or eBay orders)
   •    Alibris

Aol and Homail users , please read the AOL & HOTMAIL section.
ACCOUNT SETTINGS

User Information
Press the Account Settings button, and select the "User Information" tag to enter your contact information. This is very important, so please enter an email address that you check regularly.

Order Imports Tab

Note: Amazon orders are now imported from the Order Fulfillment Report, starting with version 2.0. E-mail option has been eliminated.

Half.com sellers have an option of importing orders from e-mails or from FTP account (Power sellers only).

eBay orders are being processed from PayPal e-mails.
This window is where you set up and turn on/off importing from your seller accounts, respectively for each one of them, using the checkboxes. The field labels for the login parameters are self-explanatory. Please note that the login parameters in this window are not your email account parameters, but the seller login parameters, which are required for the program to communicate with Amazon, Half.com (only for Power Sellers) or eBay. The program must communicate with them in order to properly download and upload files which contain orders and modify data.
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E-mail Accounts

You don't need to set up any email accounts unless you use the Autoresponder to send emails to your customers, or you receive notification emails from Half.com and/or eBay. Please note that the program downloads emails directly from your mail server, not from any local program on your computer! So don't expect it to import orders from your email client (such as Outlook Express or MS Outlook).

In the "Account 1 e-mail address" field you need to enter the email address to which you receive your notification emails. After you have done so, just press the ENTER button, and the program will try to autodetect your username, your incoming and outgoing server, and fill in the appropriate fields. If it succeeds, you just need to add your password. If the program fails to autodetect your mail servers, you will need to enter all the login parameters manually. Lookup your mail client (probably Outlook Express or MS Outlook?) email account to see how you set up the mail servers there. 

If you want to use Mail Extractor for two email accounst, click on the "2" button, and repeat the same procedure, and the program will store your data respectively. So when you want to download emails from any of these two email accounts, you will need to press the appropriate button (1 or 2) to set an account active before Getting Orders.
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Since Mail Extractor downloads emails directly from your mail server, users who use an email client program (Outlook Express, MS Outlook, Eudora, or any) must configure the client to leave emails on server after it downloads them! Otherwise emails will be deleted by your email client, and Mail Extractor will be unable to download them from your server.

Configure your mail client (Outlook Express, Eudora....) 

E-mails are received and stored on the mail server. E-mail clients like Outlook, Eudora and Mail Extractor are used to retrieve (download) e-mails. They can also instruct mail server to mark messages as read or delete them from the server completely. It is important to synchronize e-mail clients, so they can all download the mail from the mail server.  

In most mail clients there is an option "Leave a copy of messages on server", or something similar to that. This option instructs the program to leave your emails on the mail server after being read, i.e. it does not delete them. However, you will surely need to delete e-mails after being read by programs, your email client, and Mail Extractor. Both the programs can do it. If you set Mail Extractor to delete your e-mails (not recommended), make sure that you first download them in your email client (just to have your saved copy, as an archive), because Mail Extractor e-mail deletion is not reversible, it works immediately, during download. However, if you want your standard mail client to do it (recommended), then it offers additional options as to when it should delete the read e-mails. 
For instance, if you use Outlook Express, you can check "Remove messages from server when deleted from 'Deleted items'". This means that your emails are going to be deleted from server when you delete them from 'Deleted Items' folder, i.e., when you delete them permanently from Outlook Express. The next Send/Receive session will actually delete them from your mail server.
A different solution is to check "Remove from server after X days" (recommended, at least 3 days), where X means a number (1,2,3,...). This way emails get deleted from server automatically after a specified number of days, not requiring you to delete them from 'Deleted Items'. You should consider number of e-mails and the size of your Inbox, because your server might get overloaded before the specified number of days expires.

	Instructions for Outlook Express / MS Outlook:
Click on Tools/Accounts/Mail tab/, then double click on your email account. Under Advanced tab, check: "Leave a copy of messages on server". If you understood the above explanation, also check "Remove messages from server when deleted from 'Deleted items" or "Remove from server after X days", according to your needs. 

	Instructions for Eudora:
Click on Tools/Personalities/, then right click on your Persona (in the left Personalities window). In pop-up menu click properties, and then under Incoming Mail tab click: "Leave mail on server". If you understood the above explanation, also check "Delete from server when emptied from Trash" or "Delete from server after X days", according to your needs. 

	Instructions for Netscape Communicator:
Click on Edit/Preferences, expand Mail & Newsgroups, and select Mail Servers. Under the POP tab check "Leave messages on server after retrieval". If you understood the above explanation, also check "When deleting messages locally, remove it from server".


Don't download already downloaded messages
Mail Extractor remembers the ID of each downloaded email. If you check this option, then while downloading, Mail Extractor will skip already downloaded emails, and avoid creating duplicates.
Delete messages from server, after downloading
This option is unchecked by default. Leave it if you don't want your messages being deleted from your mail server after being downloaded. However, if you want Mail Extractor to delete your emails, then check this option (not recommended). 
My outgoing server requires authentication
Some outgoing (SMTP) mail servers require you to authenticate your access, especially if you are connected to the Internet through a different ISP than your mail server. This option affects only sending emails from Autoresponder, a special feature of Mail Extractor. While trying to send emails, you may receive an error message. In that case, you should try to inverse the state of the option and retry to send you emails. To avoid guess work, check this setting in your mail client (if you have previously set up the same email account in it).

SMTP port number
Most users will leave this number intact, but there are cases when your ISP requires a different outgoing port number. Otherwise you won't be able to send emails from Autoresponder.

Settings...
Open the Settings window if you send emails through a different SMTP server than your recipient email account. In that case you need to specify a different username and password than for your incoming server. To enter other username and password, you first need to select “Logon using”. 

Serial Number
As soon as you purchase Mail Extractor, you'll receive an email from PayPal with a Serial number. E-mail will be sent to your e-mail address on file with PayPal.


 Don't give away your serial number. If two programs are detected to have the same serial number, they'll be both disabled without warning!


AOL & HOTMAIL USERS

AOL users just need to properly set up their account to download emails from IMAP server (not POP).

Incoming server (IMAP): imap.aol.com
Outgoing server (SMTP): smtp.aol.com
Account name: your_AOL_email_address
Password: your_AOL_password
Hotmail users must install an additional program in order to use Mail Extractor, because Hotmail do not allow third-party programs to read their emails. Fortunately, these programs can mediate in this and enable reading Hotmail e-mails in any mail client, as well as in Mail Extractor.
Download Hotmail Popper from www.boolean.ca. This program is free until you upload and download 100 emails. The set up instructions are on their web site. Mail Extractor needs to be configured just as you would configure Outlook Express. Here are the parameters:

Incoming server (POP): 127.0.0.1
Outgoing server (SMTP): 127.0.0.1
Account name: your_Hotmail_email_address
Password: your_Hotmail_password
IMPORTING ORDERS

AMAZON MARKETPLACE SELLERS

Everything that follows in this section applies also to Amazon.co.uk Marketplace 

In order to import your orders from Amazon, you first need to enter your amazon seller nickname, amazon username and password in the Account Settings/Order Imports window. Set the number of days for which you want the report. (we recommend 4 days, considering the gap between Friday and Monday). Simply click on Get Orders buttons.
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Whenever you press Get Orders, a window will show up in which you can select an 'ad-hoc' combination of parameters as to what type of orders you want to import. The only parameter that will be memorized as if changed in the Account Settings window, is the number of days for which Amazon Order Fulfillment Report is generated.

Click on OK to continue with order download.
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The program keeps track of your orders, and it never imports the same order twice. However,
If you have installed the new version over any of the previous versions of Mail Extractor, please notice that the program does not keep track of your Marketplace orders imported from emails! The program will initially (only the first time) import some orders you have most likely already imported in the old version. To resolve this one time inconvenience,  just delete the duplicates.

The imported orders have different background colors, depending on the shipping method. Standard mail orders have white background, while expedited orders have green background. International orders have red background.
Previous versions of Mail Extractor have been able to import some additional item info from Amazon details web page. However, this is no longer possible because Amazon Order Fulfillment Report do not contain any link that would enable the program to access the unique web page for your listing on Amazon. 

However, this is now possible by importing Amazon Open Listing Report to Inventory Manager. Therefore, to have the additional details imported together with your orders, you will first need to import the Amazon Open Listings Report into your Inventory Manager and later import all Add/Modify/Delete files through Inventory Manager. To do so, just click the Inventory Manager button, click Import/Export, select the IMPORT tab, select "Amazon Open Listings Report (purge and replace AOLR)", and hit "Close & Perform". Later, whenever you Add/Modify/Delete items to Amazon, use the "Inventory Loader File" option to add the items to your local inventory as well. 

If importing any item with a SKU that already exists in the local inventory, it will be updated with the new price and quantity. The rest of the fields for that record will remain unchanged. If you want to replace the entire record of an item, you actually need to delete it and then import new items. Use the Search option in the Inventory Manager to easily locate items. Also, note that the Quantity field is editable, and you can change its content as you like.

The program automatically updates the Quantity field in your local database, according to the Quantity in your orders and upon request uploads/generates Add/Modify/Delete file.
Select the "Order fields" tab in the main window to browse some of the most important fields of your orders. Or you can select other tabs to see the address fields.

HALF.COM POWER SELLERS

If you are a Half.com Power Seller, you can have access to the Half.com FTP server. If you select this option in Mail Extractor, it will import your Half.com order files from the FTP server.
Frequency

A seller can determine the frequency at which order files are received by selecting one of the following queues:

· Once per day delivered at 8 AM EST

· Once per day delivered at 10 AM EST

· Three times a day delivered at 5 AM, 1 PM and 10 PM EST

· Once per hour 

Please notify loadingsupport@half.com with your choice for a queue.  You may also need to request Automated Order Processing (Order folder will be created on your FTP account). 
. 
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HALF.COM SELLERS

Non-Power Sellers can import ordes by downloading the notification emails, like in the previous versions of the program, or from File Exchange, which requires subscription, however it's free. When importing from emails, make sure to select "Import my orders from my Half.com emails on my mail server". Now you don't need (and cannot) enter your Half.com login parameters anywhere in the program, but you do need to enter your email account parameters in the "E-mail Accounts" tab. Please refer to the "E-mail Acccounts" section for more details on how to set up your email account, and configure your mail client.
The import process goes like this: when you press the Get Orders button, the program tries to connect to your mail server, and starts downloading your Half.com notification emails. It downloads messages starting from the latest, and finishes at the first message found on the mail server. This way of downloading enables you to perform the download as fast as possible, because you can cancel it anytime, as soon as you download the newest orders. So you don't have to wait until ME scrolls through all the messages. 
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Since non-Power Sellers have no SKU for their items, there is no way for this type of orders to integrate in any way with data in the local database. Therefore any additional data nout found in the email must be retrieved from the Half.com order details page on web. To turn this option on, check "Download extra details from Web (only non-Power Sellers)". This option might be temporarily unavailable, ie. useless due to the recent changes on Half.com! Also, in order for this to work, you must allow Internet Explorer to accept cookies, and you should have logged with it in your web Half.com account at least once, and check "Keep me signed in" on the login page.
Importing Half.com orders from eBay File Exchange 
As of October 2005, Half.com has introduced a new option – File Exchange, which makes possible for mid- and high-volume sellers to manipulate their online inventory by uploading files to eBay through the File Exchange web interface. Also, File Exchange allows for creating custom schedules to generate various order reports (but this is possible only if the seller is subscribed to another subscription that is not free, such as Selling Manager Pro). The least interval for which it can create reports for your items sold on Half.com is one hour. You must create such a schedule, and File Exchange will start filling your eBay database with links to the generated reports. Mail Extractor now can pick up these reports, and import your orders from them. Users who don't want to subscribe to one of the other eBay tools cannot create download schedules, but are still allowed to create the reports manually. Please visit http://k2b-bulk.ebay.com/ws/eBayISAPI.dll?SMDownloadRequest&ssPageName=STRK:ME:LNLK to create a manual download request. The average time that eBay takes to actually create your report is a few minutes, but as stated by them, it may take much longer, which may depend on the number of sale records you have asked for. Mail Extractor keeps track of your orders, so you can use both the scheduled and manually created reports, without fear that you may get duplicated orders. 
This is the link where you create and edit your eBay File Exchange schedules: http://k2b-bulk.ebay.com/ws/eBayISAPI.dll?SMDownloadScheduleSuccess&ssPageName=STRK:ME:LNLK 
Make sure to provide your eBay login paramters in the Account Settings window! Also, in the same window, you need to select "Import orders from my eBay File Exchange account", under setting for Half.com. Please be aware that this selection also specifies how your items will be uploaded to Half.com if you use Inventory Manager for that purpose.
If you have recently logged with your Internet Explorer to a different Half.com/eBay account than the one you want to import your orders from, make sure to sign out before using Mail Extractor to import the orders. Otherwise, it may connect to the other account and import the orders you didn't want to import.
An important advantage of the File Exchange is that it gives your buyer's email in the sale reports.
eBay SELLERS
eBay sellers can import their orders from PayPal notification emails (you must have PayPal account), or from their eBay File Exchange accounts. File Exchange is a relatively new feature on eBay, that completely replaces the abandoned Bulk Catalog Lister. It allows for manipulating your online eBay inventory by sending files through File Exchange web interface. Also, you can import your orders from File Exchange reports, which are automatically generated according to customs schedule, defined by you (but this requires another subscription that is not free, such as Selling Manager Pro). Users who don't want to subscribe to one of the other eBay tools cannot create download schedules, but are still allowed to create the reports manually. Please visit http://k2b-bulk.ebay.com/ws/eBayISAPI.dll?SMDownloadRequest&ssPageName=STRK:ME:LNLK to create a manual download request. The average time that eBay takes to actually create your report is a few minutes, but as stated by them, it may take much longer, which may depend on the number of sale records you have asked for.
Mail Extractor should work fine for sellers who sell on eBay Store's.
If you want to import your eBay orders from your paypay notification emails, first make sure to properly configure your email account in the Setting Accounts window (see the "E-mail Accounts" section), and to enter your eBay login parameters in the same window. Don't forget to turn on the option (checkbox). The login parameters are mandatory, otherwise the program won't be able to get additional details from your local database. You must follow a specific procedure in order to successfully work with eBay orders in Mail Extractor. In order to learn how to properly upload your inventory items to eBay and your local database, please refer to "INVENTORY MANAGER" section.

Sellers who upload inventory to eBay through the eBay website, cannot put more than one shipping option for each item, and allow your buyers to choose between standard and expedited shipping methods. This information is not always clearly stated in the PayPal emails, so in order for Mail Extractor to recognize standard versus expedited mail when importng orders from PayPal emails, you will need to specify shipping price in the Shipping Method Defaults Window. However, this is not used when orders are imported from File Exchange, because the File Exchange sales report does contain the shipping method information.
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Importing eBay orders from eBay File Exchange 
Please read the first previous paragraph, about File Exchange. We will here go in some details on importing from File Exchange. 
First, the scheduled report that Mail Extractor imports orders from is of the "Paid & Awaiting To Ship" type. (Use the same type when manually creating the reports). Mail Extractor keeps track of your orders, so you can use both the scheduled and manually created reports, without fear that you may get duplicated orders. Please visit http://k2b-bulk.ebay.com/ws/eBayISAPI.dll?SMDownloadRequest&ssPageName=STRK:ME:LNLK to create a manual download request.
This is the link where you create and edit your eBay File Exchange schedules: http://k2b-bulk.ebay.com/ws/eBayISAPI.dll?SMDownloadScheduleSuccess&ssPageName=STRK:ME:LNLK
Secondly, and naturally, you must provide yor eBay login parameters in the Account Settings window, and make sure to logout with your Internet Explorer from any other eBay account you may have recently logged on to. If you don't do this, Mail Extractor may import orders from that other account, and you may know be aware of it. The whole issue is related to system cookies. This may be overcome in the future versions of the program. 

Third, in the Account Settings window, select "Import orders from my eBay File Exchange account", under eBay options. Please be aware that this selection also specifies how your items will be uploaded to eBay if you use Inventory Manager for that purpose.
ALIBRIS SELLERS
It's very simple here. Just make sure to provide your Alibris login parameters in the Account Settings window, and turn on the option to include importing from Alibris when getting your orders. The orders are imported in a few seconds, and the program does not import duplicates.
CONFIRM/CANCEL ALIBRIS ORDERS
Here's a distinctive and important feature only for Alibris. You can confirm/cancel your Alibris orders in a batch, just by setting SHIP or CANCEL value of the order in the STATUS field in the main window. After doing so, you need to choose Tools >Confirm/Cancel Alibris Orders in the menu, and the program will do the job.
INVENTORY MANAGER

Importing  items and creating inventory upload files

Everything in this section that refers to Amazon.com Marketplace, also applies to Amazon.co.uk 

This is a new feature in Mail Extractor. It allows you to keep track of your items, and to upload your items to Amazon, Half.com (Power Sellers) or eBay, either automatically or manualy-by creating the upload file that is to be uploaded manually. It is also essential when it comes to additional data (seller comments, ISBN, etc) not contained in imported fulfilment report or emails. Every time the program imports an order, it looks-up this database to look for additional details, which should always be there if you regularly import your items to the database.

If you don't sell on eBay, you should completely disregard the upper half of the Inventory Manager window and "Conversion Templates" menu item. 

Regardless of the selling venue, you will first need to import your latest Amazon Open Listing Report to Inventory Manager. 

Before you do this, press Import/Export and select the "UPLOAD OPTIONS" tab. 

The first checkbox is checked by default. You should also check the Half.com check box if you sell on Half.com (Power Sellers). We will later explain what about when you sell on eBay as well. Now, sellect the "IMPORT" tab, and select Amazon Open Listings Report (Purge and Replace AOLR). Press Close&Perform, and locate your latest Amazon Open Listings Report when promted in the dialog box. The program now imports it to your local database. If you have checked the Half.com checkbox in the UPLOAD OPTIONS tab, the program internally converts your inventory to Half.com upload format, and it will offer you to either upload it automatically (connecting to Half.com FTP server), or just to create the upload file, which you can later upload manually as you usually do. Please notice that no automatic uploading to Amazon takes place in this case, because there is nothing to upload to Amazon, even though you have checked the Amazon option. Also, please notice that importing your Amazon Open Listing Report first competely empties your local database. So you should do this only once – when first using the program, or later if you want to make a fresh start. Your inventory on Amazon and your local inventory are now virtually equal. 

Later, when ready to upload more items to Amazon (Half.com and e-bay) Inventory Manager will do it automatically for you. Simply import Inventory Loader File to Inventory Manager and either let the program automatically upload the file or save upload file to your PC. 

It is essential that all uploads are done through Inventory Manager. 
To import the Inventory Loader file, select Inventory Loader File in the "IMPORT" tab, and press Close&Perform. The first and the third option in the "IMPORT" tab are the only imports that Amazon or Half.com sellers will ever need to use. The second and the fourth option are only for eBay sellers!

Now since this might have been confusing, here's a short summary of how specific sellers should use this feature.

AMAZON SELLERS

- Check only "Create Amazon Upload File when importing Inventory Loader files".

- Import your latest Amazon Open Listing Report (only once, at the beginning). It must be the original file – it must not be changed by Excel or any other program.

- Import your Inventory Loader files through the program instead of uploading them manually through the Amazon web site.

AMAZON.CO.UK MARKETPLACE SELLERS

- Check only "Create Amazon.co.uk Upload File when importing Amazon Open Listing Report files or Inventory Loader files".

- Import your latest Amazon Open Listing Report from Amazon US (only once, at the beginning). It must be the original file – it must not be changed by Excel or any other program.

- Import your Inventory Loader files through the program instead of uploading them manually through the Amazon web site.

UPLOAD OPTION FIELDS in IMPORT/EXPORT for AMAZON.CO.UK SELLERS

· Enter the current value of the British pound in the currency converter field BEFORE importing items.
· Enter a value in the "Additional fixed cost" to compensate the postage difference between domestic (US) orders and Europe orders.

· Specify your shipping destination preferences in the lower radio button group
HALF.COM SELLERS

We assume that every Half.com seller sells on Amazon as well. So everything that is said above for Amazon sellers, applies to Half.com sellers, too. 

Half.com Power Sellers should also check "Create Half.com Upload File when importing inventory files (Power Sellers)". When this option is turned on, every time the seller imports items to the local database (Inventory Loader file), the program will make internal conversion of the file to Half.com format which can be uploaded by FTP. The program will prompt you if you want it to do it automatically, or if you just want to create the upload file, so that you can later upload it to the FTP server though an FTP client.

Important: When sending 2 or more files to Half.com, wait at least one minute between file creation... otherwise, the file names are going to be identical and may replace/cancel each other.

EBAY SELLERS

We are assuming that every seller sells on Amazon as well, otherwise importing your items to the local inventory database is impossible, because only the formats of files used on Amazon are accepted. So everything that is said above for Amazon sellers, applies to eBay sellers as well. 

However, eBay sellers should also check "Create eBay Upload File when importing inventory files". When this option is turned on, every time the seller imports items to the local database, the program will make internal conversion of the file to eBay format. It will prompt you if you want it to do it automatically, or if you just want to create the upload file, so that you can later upload it to eBay File Exchange through their web interface. In previous versions of Mail Extractor this has been achieved by Bulk Catalog Lister, but eBay has now replaced it with a new and better feature - File Exchange, which also works for Half.com.
Please notice that eBay is here rather different than Amazon and Half.com, and requires a bit more complex procedure. Namely, this is where the fields in the upper half of the Inventory Manager window take part. When you import the items to the local database, the values in these fields will be used for the eBay upload file.*  

You may notice that the eBay conversion template fileds are different than that for Bulk Catalog Lister. It is because File Exchange allows for more and different options.
If not all of your items for eBay are to be with the same parameters in these additional fields, you must import them in batches. Use the Conversion Templates (from menu) to save and open combinations of the parameters as files. If you want to import your orders (batches) from the Amazon Open Listings Report file, then you need to manually create small files with the items you want to import in a batch, copying them from the original report file. 

After you have imported (and uploaded) all your eBay items, you will need to do another thing, which must not be omitted if you want to successfully process your fulfilled eBay orders. As you may already be aware, once the file(s) is uploaded to eBay, a certain processing time will pass, and you will receive a notification email from eBay which leads you to the web link http://bulksell.ebay.com/ws/eBayISAPI.dll?FileExchangeUploadResults&ssPageName=STRK:ME:LNLK wherefrom you can download the result file.You get one result file for each uploaded file. They contain eBay ItemID – the essential link for your items. It is also used when updating your items on eBay with modify files, and when the program looks for additional item data after an order has been downloaded in the program. Select the fourth option in the "IMPORT" tab, and press Close&Perform to import the eBay result files. 

eBay Template Fields
File Exchange allows for specifying up to three different shipping methods for domestic and international shipping, respectively. You can select any combination you like. The white "cost" field defines the value of the first item shipped, while the cost value (under A.S.D) defines the additional cost for the shippment for any additional item, that is if the quantity ordered for the listing is more than one. If you left the yellow box zeroed, it will be regarded as if it has the same value of the white box on the left to it.
In order to select an International shipping method, you first need to specifies the regions you are wiliing to ship to. In you ship anywhere on the world, select Wordwide, and if you ship only to specific regions, select "US + Region" and specify the additional regions.

If you want to apply shipping discount when the buyer creates a combined payment, select the appropriate check box, in the upper right corner of the window. You can learn more about the Combine Payments on http://pages.ebay.com/help/sell/combined_payments_ov.html, and on the Shipping Discount on http://pages.ebay.com/help/sell/shipping_discounts.html
You can set your global Shipping Preferences on http://payments.ebay.com/ws/eBayISAPI.dll?SoldGlobalPreferences&mode=0
ALIBRIS SELLERS

We assume that every Alibris seller sells on Amazon as well. So everything that is said above for Amazon sellers, applies to Alibris sellers, too. 

Alibris sellers are offered some additional upload options like on Alibris upload web page.
The Alibris complement of Amazon's Seller Comment field is Alibris Item Condition. However, since Alibris is very restrictive about the content of Item Condition and is prone to alter it, you can choose from the two options before uploading your items from ME to Alibris:

· to post your Seller Comments as Alibris Item Condition, without changes, or

· to post ISBN + custom text, as you Alibris Item Condition

The option selection is provided in the small Alibris tab, as shown on the picture,.
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EBAY CONVERSION TEMPLATE FIELDS & OPTIONS
	FIELD or OPTION
	DESCRIPTION

	US Shipping Methods
	At least one US shiping method is required. You can add more in the lower fields.

	International Ship. Methods
	Optional fields for international sellers.  Three different shipping methods are offered simultaneously.

	Insurance Options
	Specifies the insurance options for the shippment. 

	Sales Tax State
	State that is associated with the Sales Tax. You can't specify a value in this field unless Checkout Details Specified is checked.

	Sales Tax Percent
	Sales tax percent for the item. Pass 0 to remove a sales tax percent for the item, if already on eBay. You can't specify a value in this field unless Checkout Details Specified is checked.and a Sales Tax State is selected.

	Listing Duration
	Number of days the auction will be active. Choice of values depends on the listing type. GTC means that the item will be automatically relisted every 30 days, unless canceled (Good Till Cancelled)

	Ship To
	Specifies where the seller is willing to ship the item.

	Shipping Regions
	You can't select these arguments unless "US + Shipping Regions" is selected in Ship To.

	Store Category
	Your custom ebay store category in which you want to place your items. If you don't want to place them in a specific category of yours, just select "Other". You can create up to 19 custom categories on eBay. Although custom labeled on eBay, they are here referenced to by category numbers (1-19).

	PayPal Email
	Seller's email address on file with PayPal that is associated with the item.

	Item Location
	Indicates the geographical location of the item. It is the place from which the item is shipped. City and State should be sufficient.

	Payment instructions &
Return Policy
	Enter here anything you find important for buyers to know when buying from you. Also, use it to indicate the shipping method by which you send the item (standard, expedited, etc). There is no other field to put this information in. At this point, buyers cannot choose among several shipping methods, you must indicate a fixed one.


EXPORTING  items and creating eBAY DELETE file

If you want to export your entire local database in the Amazon Open Listings Report file format, just select the corresponding option in the EXPORT tab, and press Close&Perform. This is very useful, eg. in case you need to initialize your Half.com inventory, posting the exact copy of your current local inventory. Also, if you forgot to check the option for creating the eBay upload file, you can export, and re-import the inventory, but this time with the option turned on.

Select "Export (create) eBay Delete File for ALL local database listings" to create eBay delete file. Upload it to eBay, and it will delete all your items on eBay. Of course, this is true only if you have previously imported result files. Without eBay Item IDs, nothing will be acomplished.

DESCRIPTION OF COLUMNS

There are ten different columns in the main panel. Some of the column fields are automatically filled in with data, while others are blank and are filled later either automatically, or manually by you.
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A – this field is for "highlighting", "selecting", "activating".  It is checked by default for every new record. Every A-checked order is subject to Mail Extractor's operations, while unchecked orders are skipped. To deselect (uncheck) all orders, press the "Deselect All" button. To select (check) all orders, press the "Select All" button.

ORDER# - This  field contains the order number, as found in the email. To make better distinction, order numbers have different color for Marketplace, zShop, and Half.com, respectively.

SUBJECT – This field contains the email Subject, showing only the interesting part. If you want to see the entire original subject with the prefix, uncheck Configuration -> Smart Subject. This field is the only field that streches with the window, allowing you to see the entire text. Anyway, you can position the mouse above it anytime, and you will see the entire subject in a yellow pop-up hint.

DELIVERED – This field shows the delivery time of the message ie. when the email reached your mail server. In case you don't import your orders from emails, it is the time when the order has been placed.

STATUS – Check this field if you must cancel the order. The purpose is for your own evidence, and to trigger Autoresponder - to send a different email to your customer than for the shipped orders. You can check or uncheck this field anytime without fear, because it does not run any specific operation. Sending emails from Autoresponder is explained later, and is a separated process.

SHIPPING (METHOD) – This field is automatically filled in by the program itself. However, you can change its value anytime. During download, the program detects the shipping method selected in the email, and fills in the field according to the shipping method specified in Tools –> Shipping Method Defaults.  

For standard orders you can choose between:

Media Mail and First Class Mail.

For expedited orders, you can choose between:

Priority Mail, First Class Mail, Flat Rate, Flat Rate Box, UPS, FedEx, and DHL.
The default shiping method settings affect only orders yet to be imported. You can not convert the shipping method in a batch for orders already imported.

WEIGHT – Similar to the above, the value of this field is specified in advance in the window which opens if you click Tools –> Shipping Method Defaults. The value is in pounds (lbs), except for the First Class Mail, when in ounces (oz). The value of the field can be changed only manually.

TRACK #  (TRACKING ID) – This field is very useful, and is filled in after printing the postage with Endicia's DAZzle. The option is possible only for Endicia Premium subscribers! The value of the field is the tracking number of the package which you send to your customer. It is a value generated by USPS, and transeffered back to Mail Extractor through DAZzle Designer using the XML protocol. You can edit this field and enter any value into it, but its primary purpose is as described above. You can send Tracking ID to your customer from Autoresponder. Moreover, you can send an automatically created web link (based on the Tracking ID) to the page where the customer can track his package.

MP – means "My Price". This is a numerical field in which you can enter eg. your cost of the book. 

GROUP – This field is very useful if you download and process orders more than once during a day. When you try to print from Mail Extractor, you will be prompted whether the program should automatically assign a group number to your orders, prior the actual printing. If you hit Yes, all the orders in the main window will be assigned a group in the following format, according to a current date: MM/DD/YY-@. Here MM stands for month, DD stands for date, YY is for year, and @ is a letter. The first group printed in a paticular day will be assigned 'A' as a suffix letter. The next group during the day will have the same date, but will be 'B' assigned, etc. As soon as the date changes, the new group suffix will restart from 'A'. This will help you make a good distinction between your printouts. You can turn off this option in Configuration -> Prompt for Groups. You can easily restore entire groups from the Backup window, with a click of a button. Right click on a single message and restore entire group back to main panel of MailExtractor.
SORTING

The orders in the main window can be sorted in 5 different ways:

1. By date – descending

2. By date – ascending

3. By SKU – alphanumeric

4. By SKU – numeric

5. By Shelf

The difference between 3. and 4. is the way in which SKU's are treated. If your SKU's don't contain just numbers, you should use the alphanumeric sort, because Mail Extractor have to use your SKU's alphanumeric value to determine their position in the row. However, if you use only numbers to form your SKU's, then you can use the numeric sort and your orders will be sorted by your SKU's real numeric values. 

Sort by shelf is the sort method for the users whose SKU's start with "S_X;". The "X" is any number. The orders will be sorted by numerical values of "X"s in your SKUs.

EXPORTING

Your orders can be exported from the main window to a text file. The format of the file can be "CSV" (Comma Separated Values), or "TXT" which is actually the CSV format, but the file extension is different. The CSV file is directly openable by MS Excel. The order data are divided into fields: SKU, Title, ISBN, ListingID, Order#, Buyer Name, etc.

EXPORT FIELDS

	MARKETPLACE
	HALF.COM
	EBAY.COM
	ALIBRIS

	LISTINGS
	LISTINGS
	SKU
	Item ID

	SKU
	SKU
	TITLE
	Title

	TITLE
	TITLE
	ISBN
	Author

	ISBN
	ISBN
	Quantity
	Media Type

	ASIN
	UPC
	Condition
	ISBN

	Quantity
	Quantity
	Price
	UPC

	Condition
	Condition
	ORDER#
	Quantity

	ListingID
	Price
	Shipping Method
	Quantity in Stock

	ORDER#
	ORDER#
	Shipping Address
	Condition

	Time Of Sale
	Shipping Method
	Seller`s Comments
	Seller List Price

	Shipping Method
	Private Notes
	Buyer Name
	Seller Payable

	Buyer`s Price
	Shipping Address
	Credit
	Ship. Reimbursement

	Amz. Commission
	Seller`s Comments
	Total
	Alibris PN#

	Shipping Credit
	Buyer Name
	My Notes
	PN Created

	Your Earnings
	Commision
	Tracking#
	Alibris ID

	Shipping Address
	Credit
	Shipped on
	Shipping Method

	Buyer`s Email
	Total
	Weight
	Shipping Address

	In Stock
	My Notes
	My Price
	Item Condition

	Seller`s Comments
	Tracking#
	Order Status
	Tracking#

	My Notes
	Shipped on
	SHIP TO
	Shipped on

	Tracking#
	Weight
	ADDRESS LINE1
	Weight

	Shipped on
	My Price
	ADDRESS LINE2
	My Price

	Weight
	Order Status
	CITY
	Order Status

	My Price
	SHIP TO
	STATE
	Ship To

	Order Status
	ADDRESS LINE1
	ZIP
	Address Line 1

	Buyer Name
	ADDRESS LINE2
	COUNTRY
	Address Line 2

	SHIP TO
	CITY
	
	City

	ADDRESS LINE1
	STATE
	
	State

	ADDRESS LINE2
	ZIP
	
	Zip

	CITY
	COUNTRY
	
	Country

	STATE
	
	
	

	ZIP
	
	
	

	COUNTRY
	
	
	


EXTRACTION – DEFAULT, ALTERNATE, INVOICE

Simply click on any of the three extraction buttons (Default,Alternate,Invoice) for extraction to take place (for customizing the extraction templates see EXTRACTION OPTIONS AND EXTRACTION TEMPLATE EDITOR section).
In Mail Extractor extraction means "showing specific data imported from orders". The program provides four different extractions for each of the seller order types (Marketplace, zShop, Half.com, eBay) – Default, Alternate, and Invoice. The four extractions have equal features, and the names are conventional - just to make a better distinction. Each extraction is based on a customizable template, which means that you could possibly have 12 different templates: 3 x (Marketplace, zShop, Half.com, eBay).

You can use Default template to print picking list. You can customize the template so that it contains only the data you need in order to pull ordered items from the shelf (SKU, ISBN, Condition, Quantity, Title etc.). 

The Alternate template can be customized for printing a different set of data.

The Invoice template can be used for printing Invoices.
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Here's a sample extraction (for two orders):

John Malabir

Dept #43-0279 7501 N.W 17th Street Miami, Florida 33026 U.S

Miami, Florida 63126

_________________________________________________

ORDER#: 058-0938082-8569966

TITLE: Foreign Affairs [Paperback]  by Lurie, Alison 

ISBN: 0380709902

CONDITION: Used - Very Good

SKU: A002736
QUANTITY PURCHASED: 1

SHIPPING METHOD SENT: Media Mail

SHIPPING METHOD SELECTED: Media Mail

TIME OF SALE: 12-Mar-2004 13:12:39 
QUANTITY IN STOCK: 0

SELLER COMMENTS: Gently read. Clean, tight and bright.

------------------------------------------------------------------------

Daniel Taylor

4506 Dallas Ave.

Santa Monica, California 90103

_________________________________________________

ORDER#: 058-6112631-3727505

TITLE: The Runaway Bunny [Board book]  by Brown, Margaret Wise; Hurd, Clement 

ISBN: 0061074292

CONDITION: Used - Very Good

SKU: A003426
QUANTITY PURCHASED: 1

SHIPPING METHOD SENT: Bound Printed Matter

SHIPPING METHOD SELECTED: Media Mail

TIME OF SALE: 12-Mar-2004 12:40:32 
QUANTITY IN STOCK: 0

SELLER COMMENTS: Gently read. Tiny bump to spine top on back otherwise clean, tight and bright board book.

------------------------------------------------------------------------

EXTRACTION OPTIONS AND EXTRACTION TEMPLATE EDITOR

Click the Extraction Options button to edit the extraction templates and to set any other parameters related to the extraction.

A template contains a mixture of text and tags. Tags look like HTML tags, they are special reserved words within "<" and ">" characters. There are four different sets of tags - for Marketplace, zShop, Half.com, and eBay, respectively. The available set of tags is in the left blue panel. Double click on a tag to place it in the template, on the current cursor position. You can create any combination of tags & text. When extracting, tags are replaced with the actual value of the parameter (pulled from the email). For example, <TITLE> will be replaced with the original book item title. The text parts will remain unchanged.

You can also mix pictures with the tags and text. However, PICTURES SHOULD BE AS SMALL AS POSSIBLE IN FILE SIZE, AND PREFERABLY BLACK & WHITE!!! Black &White pictures take less memory resources, and therefore it takes less time to generate the final text.

The template showed in the editor is used to generate the above sample extraction:
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Some options in the menu of the Extraction Options Window (Extraction Templates Editor)

Edit Separator String
This is an editable character string which helps the program to know where to make page breaks when printing the text in "One record per page", ie. when that option is checked in the main window. There are more details about this string in one of the next sections.

Show Date on the Top
Instructs the program to generate the current date at the top of the extraction in the main window.

Group extraction by order type
This is a type of group sorting. It instructs the program to group the printed text by order types (Marketplace, zShop, Half.com, eBay), but still using the actual sorting method (by date or by SKU). If not used, Mail Extractor Plus will mix orders according to the applied sorting method, ignoring the order type.

SPECIAL FONTS

The "Use special fonts" option in the Extraction Template Editor is on by default. When generating extraction,  the program uses different formats of fonts, depending on one of the specificities of the order. There are the three such cases: 

· International orders

· Orders in which ordered quantity is greater than 1
· Expedited orders

This option overrides some formatting in your templates, such as color, size etc. Play with it, set different fonts, it's the best way to learn how it works.

EXTRACTION PRINTING

By "extraction" we mean the content generated when hitting any of the extraction buttons (Default, Alternate or Invoice). The extraction can be edited manually. When printing the extraction, you can choose between two modes: 

· print continuosly

· print one record per page

Uncheck "Print One record per page" to instruct Mail Extractor to print as many orders' data as can fit on one page. In this mode Mail Extractor will not split your order's data onto two or more pages, beacuse it has a smart print processor which can achieve this by detecting the Separator String*, and calculating the printing space needed for each order's data. As it detects that there is not enough space to print the complete data of an order on the current page, it passes to a new page to commence printing for that order. In this mode, Mail Extractor prints the Separator String to visually separate records one from another.

Check "Print One record per page" to instruct Mail Extractor to print the data for one order on a single page. The second order's data will be printed on the second page, etc. In this mode, the separator string is not printed.

* Separator String – a character string which represents the divider between records. You can edit this string, but please use an unusual string, which is never expected to be a part of any order's data. Otherwise, printing might be erroneous.

ASSIGNING GROUPS

Every time you hit the Print button, Mail Extractor will ask you if you want it to assign a group number to the orders. The way it works is already described in the Description of Field Columns section.

USPS COMPARE

This is a special feature which helps you to calculate the lower rate between Media Mail and Bound Printed Matter shipping methods. It compares the rates of the two methods for the given weight of your package and automatically changes your shipping method to the one less expensive (if not already selected). To use the feature, you need to enter your location's ZIP code into the appropriate field in the main window. The USPS Compare function is by default automatically started every time you send your orders to  the XML Communicator. However, the option can be turned off in the main menu (Configuration -> Prompt for USPS Compare)
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PRINTING POSTAGE WITH DAZzle Designer

There are two ways to print the postage with DAZzle: one for the Endicia Basic subscribers, and the second, far better, for the Endicia Premium subscribers. The Basic service provides less comfort than the Premium, because it does not enable the automated XML communication with other programs. The XML communication enables complete preparation of the shipping parameters in other program, such as Mail Extractor (address verification, selection of the shipping method, and setting the package weight). The Basic service enables you only to manually import the address file (into DAZzle), which you have previously manually exported from Mail Extractor. Also, it only enables manual exporting of the Log file (from DAZzle), which then can be imported into Mail Extractor. The DAZzle Log file contains all the details about the postage you have printed from DAZzle (shipping date, shipping method, Tracking ID, standardized shipping address, etc). This data can be imported in Mail Extractor, and sent to your customers from Autoresponder. If you are a Premium subscriber, importing of the shipping data is entirely automated.

Method for the Endicia Basic subscribers

The Basic subscribers can export the addresses (pressing the DAzzle button, the left one) and import them in the DAZzle. After printing the postage, they can get some shipping data back into the appropriate fields in the program which is later useful when sending your customers message from Autoresponder, or when printing the invoice (after printing the postage). The most important output data (getting from DAzzle) is the Tracking ID link, which will lead your buyers directly to the USPS web page, where they can track their package. Another use is for international orders which cannot be printed using XML method, because of the restrictions posed by USPS. Here's described the entire process:

1. In Mail Extractor, click on the DAZzle button to export addresses from orders as a CSV file. The Order# is also exported with the address.
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2. In DAZzle's Address Book click on Import (in the menu), and choose the CSV file that you've just created with Mail Extractor. When the Options window opens, map ALL fields so that Title in the left list corresponds to Title in the right list and so on. Press OK.
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The imported file now fills the "Job Title" field with Order#, as shown on the picture:
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3. In DAZzle, go to File -> Preferences&Options -> Address Book, and make sure that "Include Job Title in address" is checked. This is inevitable in order to have the expected result.
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4. Print postage with DAZzle and when finished, click on Postage Log tab, and select File > Export from the menu. Select  a starting and ending date in the pop-up window that shows up, and press Export to select a name and location for the file.
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Every shippment address in the exported Log file now also contains the Order#, which is the key that links data between DAZzle and Mail Extractor.
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5. Now go back to Mail Extractor and click on Import DAZzle Log. Select the Log file you've just exported from DAZzle. Press Open, and Mail Extractor will fill the Shipping Method, Tracking# and Shipping Date fields. 



-  IMPORT DAZZLE LOG FILE



6. When sending the Order Shipped/Cancelled autoresponder message, ME will detect if data have been found in DAZzle's Log file for the actual message. If true, that data will be used in the message, replacing the corresponding tags with the actual data.

Here is the template used to generate the lower blue text of the Autoresponder message:


Hello <BUYER_NAME>,

The package was shipped to you on <DATE_SHIPPED>, via <SHIPPING_CARRIER>, <SHIPPING_METHOD_SENT> 

to the following address:

<SHIPPING_ADDRESS>

The package's delivery confirmation ID is: <TRACKING_ID>

To check the delivery status of your package at any time please visit:

<USPS_LINK>

Package content info:

ORDER#: <ORDER#>

TITLE: <TITLE>

ISBN: <ISBN>

QUANTITY PURCHASED: <QUANTITY_PURCHASED>

SELLER COMMENTS: <SELLER_COMMENTS>

View item purchased online:

<DETAILS_PAGE_LINK>

Thank you for your purchase!


And here is the Autoresponder message generated on the basis of the above green template text:

Hello John Dow,

The package was shipped to you on 04/20/04, via US postal service, Flat Rate 

to the following address:

John Dow 

Dept #43-0759-8401 N.W 15th Street, 

Miami, Florida 33102

The package's delivery confirmation ID is: 7827286767
To check the delivery status of your package at any time please visit:

http://trkcnfrm1. usps.com/net-cgi//output?strTrackNum=7827286767&CAMEFROM=OK
Package content info:

ORDER#: 058-0938082-8569966

TITLE: Foreign Affairs [Paperback]  by Lurie, Alison

ISBN: 0380709902

QUANTITY PURCHASED: 1

SELLER COMMENTS: Gently read. Clean, tight and bright.

View item purchased online:

http://s1.amazon.com/exec/varzea/ts/exchange-glance/Y03Y1466277Y4581680

Thank you for your purchase!

7. However, if Mail Extractor finds no data in the DAZzle Log file for a message, no USPS link will be created, and only data that you manually enter will be used.
Method for the Endicia Premium subscribers

DAZzle XML Communicator allows you to print postage in batches. If you want to use this feature, you need to contact Endicia, and ask them to activate XML in your DAZzle Designer.

DAZzle XML Communicator is very easy to use:

 * Prior to printing postage select and edit the layout (label) in DAZzle.  
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In Mail Extractor click on "Show DAZzle Communicator" icon.
Click on "Options". Select the layout in the "Layout Path". Close DAZzle XML Communicator.

a) Download your messages and enter weight for each package in the Mail Extractor's main window.
b) Click  on "Send to DAZzle XML Communicator" icon  
c) Click on the "Verify" button in the XML Communicator to verify the addresses.
(when verifying individual addresses in the file (right click), click on "Verify..."
button again when finished)
d) Edit addresses by pressing F2 when on a field, then press Enter to store the change.
c) Click on "Test Printing" to make sure the layout is properly selected.
d) Click on "Printing"
e) Click on "Import Output Results" - this will import Delivery Confirmation number and other data back in Mail Extractor.

Advance Shipping Date – With this option you can precise a date that will appear on a shipping label. Specify the number of days to pass before the order is shipped.
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The output results will be owerwriten with next postage printing. 

The output results are in the "C:\Program Files\Envelope Manager\DAZzle\printME-output.xml" file. The program always creates a backup copy of the previous results and stores it to "C:\Program Files\Envelope Manager\DAZzle\printME-output_backup.xml". This backup file can be renamed to "C:\Program Files\Envelope Manager\DAZzle\printME-output.xml" if you have to re-import the output results.

ADDITIONAL OPTIONS in XML COMMUNICATOR
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Print Order # on Labels – In order for this option to have an effect, you need to check „Include Job Title in address“ option in Dazzle, File -> Preferences -> Address Book. Both the options turned on will make DAZzle print your Order # as a part of the shipping address. This is convenient for users who want this information on their shipping labels, because they cannot achieve it with Rubber Stamps. Also, if anything goes wrong when importing the output results in Mail Extractor (after printing the postage), the resulting info can also be imported from DAzzle log file, because having the Title printed as a part of the address will put it into the log file as well.
Include Delivery Confirmation – You can select for which shipping methods you require the Delivery Confirmation. If you want to manually unable/disable the Delivery Confirmation for certain orders, you can do it if you horizontally scroll the XML window, to bring the DC column into focus.

Insurance – If you also use mail insurance, select an insurance option, and enter the default  insurance value for all orders in the field below. If you want to manually edit the value for certain orders, you can do it if you horizontally scroll the XML window, to bring the INSR column into focus. Also, you can manually select an insurance option for individual records if you press the right mouse button on the record and select from the "Insurance" pop-up submenu.
Rubber Stamp – DAZzle designer allows for adding Rubber Stamp fields to your shipping labels. Mail Extractor takes advantage of this option and sends your order SKU as the Rubber Stamp field. In order to add that field to your labels, in DAZzle click Insert -> Rubber Stamp, check "Link to Address list Field", and select "Rubber Stamp 1". If you want another one Rubber Stamp, do the same for Rubber Stamp 2. Close the window, and place the field somewhere on your shipping label. Save the layout.

The Rubber Stamp field in XML Communicator is editable, and can be accessed by horizontally scrolling the window to the right



Verification Process

The XML Communicator has this ability to verify your addresses through the DAZzle Designer. The verified addresses are automatically imported back in the XML Communicator, and the quality of the verified addresses is indicated by different colors:
    Perfectly matched addresses have white background. 
    Imperfect addresses have colored background. 
    Each color has a different meaning, which is shortly described in the
    left bottom corner of the window when you click on the address.
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·  A precise match was found! – White
This result indicates a matching address was found in the Postal database and the ZIP+4 and standardized address were returned.  This is the best possible result.


· ZIP+4, but more information would help – Green
A ZIP+4 was found and can be used, but if you enter a company name or suite, you will probably get a more accurate ZIP+4.  This result is common for large buildings in which case you will often get the building's ZIP+4.  If you can pinpoint the company name, you will get the company's ZIP+4 within the building.

· Multiple Addresses, can you be more specific - Pink  (DAzzle does not print postage for such addresses)
The address you submitted is too vague - there is more than one address that matches.  This is commonly caused by not entering the type of street (e.g. Dr, St, Ln, etc.).  If your address has 123 Main and there is a Main Street and a Main Avenue you will get this result.  Correct your address and try again.

Invalid address format – Purple 
The lines of your address are in the wrong order or you did not enter enough data.

· Invalid 5 digits ZIP submitted – Orange
the five digits ZIP code entered is not correct.  Try removing the ZIP code completely and using Dial-A-ZIP again.


· State not recognized – Yellow
The state name entered is not correct.  You either used the incorrect abbreviation or seriously misspelled the state.  You may also get this result if you try Dial-A-ZIP with a foreign address.

· City not recognized - Aqua Blue
Your state is OK, but the city does not exist.  Did you misspell it?


· Address not found - Red  (Dazzle does not print postage for such addresses)
If you receive this result, the address submitted did not have a matching address in the Postal data base.  You either have a serious misspelling or a street address that does not exist.  In some rare cases, the Postal Service may not have assigned a ZIP+4to the address.  Check your spelling and street address (did you include a street number?) and try again.
Use F2 to edit address fields which have not been recognized as valid addresses. Once verified address can be re-verified as many times as you wish.

Please note that the postage will NOT be printed for the following (a label will be printed, but without postage):

- International addresses (red background)
- Addresses with multiple matches (red background)
- No match found (red background)

APO, FPO addresses will be printed WITHOUT Delivery Confirmation - DAZzle will prompt you to acknowledge this (printing will not continue until you click on "YES")

"Send to DAZzle XML Communicator" command replaces all the previous addresses from Communicator.
"Show DAZzle XML Communicator" command shows Communicator with the last records that have been sent to it.

 

PRINTING SHIPING LABELS WITH THE USPS SHIPPING ASSISTANT

Hit the "Shipping Assistant" button the export the shipping addresses to a file in the format which can be imported in the USPS Shipping Assistant's address book. It is the only automation which Mail Extractor can provide for this program.

ADDRESS FIELDS

The Address Field tab in the main window shows addresses by address fields. You can edit the fields' contents and save the changes. A good example is when a buyer asks you to send him the package to a different shipping address than in the notification email. That address will be used when using the DAZzle XML Communicator to verify or print the postage.

The "Date of shipping" field will be automatically filled by DAZzle XML Communicator, as you print the postage through it. It is the actual date value which replaces the <DATE_SHIPPED> tag in the template when using Autoresponder.

AUTORESPONDER

Autoresponder is an excellent feature from which you can send your customers emails, neatly customized, with all the relevant shippment data. The email address from which Mail Extractor sends the emails is specified in the Configuration Settings window. Mail Extractor does not utilize any of your email programs to implement this, it does it using its own email components.
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To send massages to Autoresponder, press 

  in the main window.

The Autoresponder window will open. Press the Generate Message button to generate emails.
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There are three different email types in Autoresponder: 

1.
Payment Received - to inform them that you received their order

2.
Order Shipped/Cancelled - to inform them about the shippment, Tracking ID, etc.

3.
Feedback Needed - to ask them for a feedback


The Order Shipped/Cancelled type consists of the two subtypes - Order Shipped, and Order Cancelled. Usage of the subtype is specified by the value of the STATUS field in the main window (SHIP or CANCEL). If you can't fulfill an order, just press SHIP, and it will switch to CANCEL.
The body of the email message is based on the custom template. There are four different custom templates – one for the Payment Received emails, one for the Feedback Needed emails, one for the Order Shipped emails, and one for the Order Cancelled emails.

When sending the Order Shipped/Cancelled emails, the value of the STATUS field in the main window determines which of the two custom templates (Order Shipped, or Order Cancelled) will be used to generate the email content.

Logic of creating and using templates is the same as for the extraction templates (see the EXTRACTION PRINTING section). Click on Customize in the Autoresponder's menu to work with the templates. The main difference from the extraction templates is that you can't insert pictures, and format the fonts. This is because the emails are sent in the plain text format, so any formatting would be lost anyway).

AUTORESPONDER DETAILS
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Subject Prefix – specifies the starting words of the email's subject for a given email type.

Subject Content – specifies the data which should follow the subject prefix in the email subject. It can be either:

1) Title of your item, or

2) Order#

Example
If the ordered item's title is Accounting, the Basis for Business Decisions  by Meigs, B.

and the subject prefix and content are as shown on the picture above, the resulting email subject will be: Amazon Order Received: Accounting, the Basis for Business Decisions  by Meigs, B.

When your customer receives his emails, he will see it in eg. Outlook Express as shown below.
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Each of the templates has its own Subject Prefix and Subject Content!

To assign messages from the main window to Autoresponder, just hit the right ("Send") Autoresponder button.. To open Autoresponder without sending message to it (to see what's in it), hit the left button.

TEST MODE is useful when you want to send message to your own email address, to see how they actually look like in an email client. It is active by default. To turn the Test Mode off, just uncheck the check box.

There are three interesting yellow columns to the right of the upper panel – P, S/C and F.

P is for the Payment Received message type

S/C is for the Order Shipped/Cancelled message type

F is for the Feedback Needed message type

When you send a message from Autoresponder, the appropriate field is filled with a red plus sign, indicating that you have sent the message of that type for that order.

AUTORESPONDER TEMPLATE EDITOR

The program comes with predesigned custom templates in the right panel, which you can edit as you like. Press Customize to open the template editor. 

The words between < > are so called "tags". Each tag has a special meaning, which is understandable from its name. When generating messages in Autoresponder, the tag is being replaced by actual value of the tag, depending on the actual data in the generated email.

The easiest way to insert tags into the template is double clicking on them in the left panel, or pressing Enter.

There are also two additional tags in the menu – DATE and TIME. Their actual value is the date and time value in the moment the message is generated.
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Every change in the template is automatically stored. 

Click on the tabs above the right panel to select a template for a different message type (Payment Recevied, Order Shipped, etc).

BACKUP WINDOW

In Mail Extractor, Backup is actually your orders database. All your orders are automatically in the backup. You can move your orders from the main window if you press the "Backup All" button. Also, you can put any order to the backup if you press from the pop-up window (or pressing CTRL+H). Orders visible in the main window cannot be manipulated in the backup window, until they are put to the backup from the main window!
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The "A" column is a counterpart of the "A" column in the main window. A green check mark in the "A" field means that the order is selected to be restored or deleted by "Restore All" or "Delete All" operations. To select an order, doublre click it, or press Space. To select or deselect all orders in the backup window, press "Select/Deselect All". The yellow columns are counterparts of the yellow columns in the Autoresponder.

The Message Filter narrows your view of the database to a specific time interval, so that you can browse or find your orders effortlessly.

SEARCHING ORDERS

This option is now enhanced. Searching is simultaneously performed in two following fields, and it is case insensitive:

· Order#

· ISBN

· SKU

· Item (name)

· Shipping Address

· Buyer Email

As soon as the program finds the first occurance of the query string in any of the fields, it will bring up a window and show the order data using one of the extraction templates fom the main window. Change the extraction type in the pop-up window if you want to see the order extracted in a different way. This is very useful for users who don't use the Alternate or Invoice  extraction at all. Now they can use it for reviewing their orders in searching.

CREATING MODIFY FILES

This feature enables you to keep your inventories up-to-date after importing new orders. The program uses data from the local inventory in Mail Extractor to create the files. Whenever you import an order, it updates the Quantity field in the local inventory for the sold items, so you need to update the Quantity field on the other sites. The program creates modify files only for the orders currently appearing in the main window.
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The program will offer you either to automatically upload the file to the site, or just to create it, so that you can save it on hard disk, and then manually upload as you like. 

Whichever action of the two you choose, the file is anyway created and saved as one of the following:

· C:\Program Files\Common Files\MEP\LastAmazonModify.txt
· C:\Program Files\Common Files\MEP\LastAmazonUK_Modify.txt
· C:\Program Files\Common Files\MEP\LastHalfModify.txt
· C:\Program Files\Common Files\MEP\LasteBayModify.txt 
· C:\Program Files\Common Files\MEP\ LastAlibris_Modify.txt
After uploading eBay modify file, the eBay result file with eBay ItemID's must be downloaded and imported in Inventory Manager, just as you do after uploading your items to eBay. The file will be generated on eBay File Exchange website after some time. This is essential to keep your eBay items consistent in your local database.
Important: When sending 2 or more files to Half.com, wait at least one minute between file creation... otherwise, the file names are going to be identical and will replace/cancel each other.

SAVING DATA

Mail Extractor Plus keeps its database files in "C:\Program Files\Common Files\MEP".

There are three database files:

· Data.ebd
· Settings.edb

· Inventory.edb

Data.edb contains your orders data, and the Address Book. 

Settings.edb keeps all your settings (extraction and Autoresponder templates, some temporary data, etc) 

Inventory.edb is your local database (items imported from Amazon Open Listings Report and Inventory Loader files) 

You can explicitly create a safe copy of the database files anytime if you press the "Save Back-up To" button, and select a different folder where the files are to be copied.

Anyway, Mail Extractor automatically creates safe copies anytime you close the program. They are created in "C:\Program Files\Common Files\MEP Backup". You can cancel it when prompted, but it is recommended that you accept the offer. If accepted, the program will create the copies and name them as "yyyy-mm-dd hh.nn-Settings.edb", where "yyyy" is the current year, "mm" is the month, and "dd" is the date. "hh" is the hour, and "nn" is the minute of the creation.

The files are saved and deleted cyclically, and the program always keeps maximum of four different backup copies of each database files. In other words, when it attempts to create the fifth copy of a backup file, it will delete the oldest copy of the file, and then create the new copy. Thus you can't have more than file copies. This is to avoid unnecessary piling, and at the same time to have more than safe backup.

REPAIRING THE DATABASE & RESTORING THE DATA FROM THE SAFE COPY

RepairME+ is a program utility, installed together with Mail Extractor Plus. It can repair your database if you experience problems using the program. Prior to use it, you should close Mail Extractor Plus.

However, if the utility does not help, you can restore your database from the latest safe copy.

It can be either the one you created explicitly, or one of the four backups which the program automatically creates when closing. Here's how to restore your database files from the automatic backup:

1. Close Mail Extractor Plus

2. Create a copy of "C:\Program Files\Common Files\MEP".

3. Delete Data.ebd, Settings.edb, and Inventory.edb from the original "C:\Program Files\Common Files\MEP" folder.

4. Copy the latest files from "C:\Program Files\Common Files\MEP Backup"  to the new "C:\Program Files\Common Files\MEP folder". The newest files are easy to find due to the date-signed name. 

5. Run the program, and check if it contains the latest data before the problem occured.

6. If the problem still persists, try with the 
CREATING A NEW, EMTPY DATABASE

If you can't take advantage of your backup files, you can start a new database. All you need to do is rename "C:\Program Files\Common Files\MEP" to any other name, and install the latest version of the program, which will create new database files, and you will be able to use your program again.
SCHEDULER
Scheduler is a separate program that also can be run from Mail Extractor's Tool menu. It automates the steps you would need to make manually on web in order to generate a File Exchange report for your eBay and/or Half.com sales.
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The prerequisite is that you subscribe for eBay File Exchange tool. If you have not already done so, please visit http://pages.ebay.com/file_exchange/ to learn more, and sign up for the service. File Exchange is offered free of charge!
Before using the program, you need to supply in Mail Extractor your eBay SellerID and Password.

The Notification Address does not have to be an existing address (if you don't want to be sent an email every time you have a report generated), but it must be in the valid E-mail address format.

Press the GENERATE REPORT NOW  button to generate a report for eBay and/or Half.com, depending on your selection. At least one option must be selected.

Set the Autogenerate report option to allow the program „press“ the button instead of you, at specified intervals.

The reports are usually generated in less than one minute, but this can vary in a great extent, depending on eBay's servers overload. 
Don't worry about duplicates, because Mail Extractor takes care of that, keeping track of your orders.
If anything goes wrong, and the program stops responding, just close it and run again.

HOW WE USE MAIL EXTRACTOR PLUS

We always start with no messages in the main window of Mail Extractor Plus. Backup All button will clear the main window and send all active orders to Backup window . 

Get Orders button will download all orders from the mail server/fulfilment report. Once the download is complete, extraction process is performed. 

We use Default extraction button for creating picking slip and later Invoice button for printing invoices. Alternate button is there in case you need a different set of data (all templates could be customized according to your needs, see: Extraction Options).

Print button will prompt a very important PRINTING GROUP window. 

It is of utmost importance that you assign a group to all downloaded orders in the main window. This will allow you to later manipulate entire group (send and restore from Backup) and perform a certain operation for a paticular batch (like printing postage, sending notification e-mails etc).

Once the group is assigned and picking slip printed we pull books from the shelves (note: we print 2 copies of the picking slip). All books are pulled and packed in the order they appear on the picking slip.

For pulling books we use the first or master copy of the picking slip. We write down during this time all orders that need to be cancelled. Later, we issue refunds according to the master copy. 

During the packing process, we cut the second copy of the picking slip and temporarly affix it to the package with a small piece of tape (some sellers write down the buyer's name on the package instead).

It is important to mention that special fonts for expedited mail, international orders and orders where quantity is greater >1, greatly facilitate the packing process. 

Once all the books are packed, we weigh them and write the weight and shipping method (if different) on the master copy. Shipping method and weight could be defaulted (Tools(Shipping Method Defaults).

Now, only thing left is to enter the weight and shipping method (where different-for instance Flat Priority and First Class) into Mail Extractor Plus. Using the master copy this process is fast and easy. 

Don't forget to deactivate (uncheck) 'A' field for cancelled orders (cancelled orders should be clearly marked on the master copy). 

This is a good time to make requested change of address in Mail Extractor (we first write down all changes on the master copy, then make changes in the Address field tab).

USPS Compare compares price between Media Mail and Bound Printed Matter (essentialy the same shipping methods often with different price). 

The next step would be to send all the orders to Dazzle XML Communicator, 

Verify addresses and print the postage. Every time address is changed or edited, Verification of ALL addresses needs to be performed.

Import Output Results button will import delivery confirmation numbers back to Mail Extractor Plus. At this point Dazzle XML window will close. From the main window all orders are sent to Autoresponder. Remember to activate cancelled orders prior to sending everything to Autoresponder. 

Mail Extractor Plus will send appropriate message according to the Status field (SHIP/CANCEL). 
Genereate Messages action needs to be performed first.

Autoresponder will close once all messages are sent. If autoresponder stops sending messages, you may need to right click on the first message and remove it. Click on Send button to continue sending messages.

At the end of the process, we Backup All messages from the main window into a Backup window.

Now, we're ready for another download.

Printed postage labels are in the same order as packed books. We double check to make sure names are the same on the label and temporarly affixed cutout from the second copy of the picking slip. Depending on your printer you may need to reverse page order of picking slip and/or postage labels. 

Backuped messages could be easily restored from the Backup window to the Main window of Mail Extractor Plus. Simply click on Show Backup button, find only one message from the group that you want to restore, right click and select 'Restore Group DD/MM/YY-@'. Entire group will now be restored to the main window.

This is extremely usefull if you're printing a few batches a day. You can download and print a second or third batch and then go back to do postage for the first batch of messages. You can also restore all messages from a month ago and request a feedback by sending them all to Autoresponder.
Latest changes in the new version
 - Scheduler Tool– for generating eBay and/or Half.com sale reports on File Exchange
 - Merchant US (Amazon Seller Central) updated (May 25, 2007.)
 - USPS/DAzzle changes update (May 10, 2007.)
 - Merchant US (Amazon Seller Central) fully functional again (March 29, 2007.)
 - Added ISBN-13 for Half.com emails (March 27, 2007.)
 - Made adjustments for the changed Half.com emails (March 23, 2007.)
 - USPS Shipping Assistant 3.0 Address Book format exporting
 - Alibris autoresponder feature added
 - Alibris extraction problem fixed
 - 'URLMON.DLL' problem fixed
 - Only "active" records count when creating Modify files
 - Adds SKU into Private Notes when listing on Half.com
 - Imports eBay orders also directly from eBay
 - Amazon Seller Central order importing problem fixed
 - Imports Half.com orders also directly from eBay/Half.com
 - Imports new eBay/PayPal emails, including SKU and seller Comments
 - Correctly extracts Order # from Half.com emails

Transition to the new version (2.0 and higher) 
This applies to the users who have used the old version of Mail Extractor, now obsolete.

1. Download all orders with OLD version of the program and process them (print the postage and send autoresponder e-mails).

2. Download and install new version 

3. Import Amazon's Open Listings Report to ME's Inventory Manager

4. Delete duplicate orders (because of the transition from e-mails to Order Fulfillment Report files, Mail Extractor Plus will download previously downloaded orders through e-mails). You need to do this only the first time.

5. Adjust your Amazon's inventory for new orders (if selling on half.com and/or eBay).

6. Download orders again (no duplicates will be downloaded this time) and immediately create fresh Amazon's Open Listings Report. 
Import it to ME's Inventory Manager.
From now on you can download new orders at will. 

7. When uploading new items to any of the venues or modifying quantities, make sure that you import Inventory Loader File to ME's Inventory Manager as well.
ME+ allows you to upload Inventory Loader File directly to Amazon, Half (FTP-Power Sellers only), eBay (you must have eBay Store).
You can continue uploading files through Seller Engine if you wish, however don't forget to create Inventory Loader File, save it to your PC and then import it to ME's Inventory Manager.

New users

1. Download and install new version 

2. Import Amazon's Open Listings Report to ME's Inventory Manger

3. Delete previously processed orders. 

5. Adjust your Amazon's inventory for new orders (if selling on half.com and/or eBay).

6. Download orders again (no duplicates will be downloaded this time) and immediately create fresh Amazon's Open Listings Report. 
Import it to ME's Inventory Manager.
From now on you can download new orders at will. 

7. When uploading new items to any of the venues or modifying quantities, make sure that you import Inventory Loader File to ME's Inventory Manager as well.
ME+ allows you to upload Inventory Loader File directly to Amazon, Half (FTP-Power Sellers only), eBay (you must have eBay Store).
You can continue uploading files through Seller Engine if you wish, however don't forget to create Inventory Loader File, save it to your PC and then import it to ME's Inventory Manager.
REPRICER

Introduction

Repricer is a program that allows for comparing the prices of your items with the prices of other Amazon sellers, and changing them in accordance with specified conditions and criteria. You can import your listings either from a file, or directly from your Amazon online inventory (Amazon Open Listings Report).
You can export the offers imported while performing comparations, and make use of it in an other program.

You can use a special program's feature – Scanner Loader – to easily import your items using a barcode scanner.

And finally, the program allows for simple, but effective search.

Preferences

In the Preferences window, supply your details and Amazon credentials. You cannot supply your Amazon Nickname, the program will find it automatically every time you check prices on Amazon. However, if for some reason it cannot find it, you will be offered to supply it manually.

If you are still in the trial period (Mail Extractor), leave the yellow Serial # box empty. Otherwise, supply your Serial #, which is always the same as your current PayPal subscription number for Mail Extractor.
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IMPORTING

Import from file

If you select the Custom type of file, make sure to specify the additional options that shows up in the window. 

If you select „Amazon Open Listings Report“, be sure that you import an unaltered file, because if you have previously open and saved it in eg. Excel, it may get a different format which could cause unpredicted errors.
The program generates random SKUs for any of the listings without the SKU, and uses the SKU Prefix from the Preferences window (if specified).
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Importing from Amazon – Amazon Open Listings Report

In the Import menu, select „Download and import my open listings report“ to import your listings directly from Amazon. Please note that the process may take a few minutes, because it takes time for Amazon to generate reports.
EXPORTING

Exporting Offers
This option allows for expoting other Amazon sellers' offers of the items for which you made price checking. The export is done for selected record. Here's a list of the exported fields:

SKU,Product code,Title,My price,My condition,Nickname,Seller's price,Seller's condition,Seller's comments,Location,Rating,Feedbacks

Exporting in Inventory Loader format
This option allows for expoting your listings in the format ready for importing on Amazon's web Inventory Loader - https://secure.amazon.com/exec/panama/seller-admin/catalog-upload/catalog-upload-now?fmt=tab-delimited. Here's a list of the exported fields:
item-is-marketplace,product-id,product-id-type,item-condition,item-note,price,sku,item-name,item-description,category1,image-url,quantity,add-delete,expedited-shipping,will-ship-internationally,shipping-fee,browse-path,storefront-feature,boldface,asin1,asin2,asin3
UPLOADING LISTINGS TO AMAZON

Upload Inventory Loader
This option allows for uploading selected listings to Amazon. You need to select one of the Upload Types:


Add/Modify/Delete

Purge and Replace

Modify/Delete
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SEARCHING FOR RECORDS

Searching is case insensitive, it is performed on all records. 
The following fields are included in search: SKU, Title, Product ID
After one record is found, press F3 to find the next one.

PRICE CHECKING

When checking other sellers' prices of your items, the program is also importing some other informations from Amazon, such as the original title of your items, Amazon's price, Author, Publisher, etc.

Press Start All to perform price checking on all records. Checking is done sequentially, record per record. If you want to check prices for only selected records, then press the down arrow next to „Start All“ and press Start Selected.
REPRICING OPTIONS

This is the crucial part of the program when it comes to price checking. In this window you select your conditions and criteria as to how you want your prices to be adjusted.

Use the Save button to save your settings in a file, as a template that you can later import with the Open button.
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SCANNER LOADER
This is a special feature for booksellers who would like to import their books directly to the program by scanning barcodes, although you can use it also to add items manually by typing. The prerequisite is that you organize your warehouse by numbered shelves.
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Here's how you need to import your items by scanning:

1. You need to tell the program on which shelf you keep the next items you are going to import. You can do that in two ways. The first way is directly typing Sxxxxx in the „Shelf/ISBN“ field, where xxxxx is the number of the shelf (you can use only numerics). „S“ tells the program that you are entering a Shelf, not ISBN. The other way is that you print barcode labels for all your shelves, and then use your scanner instead of typing. Of course, the barcode should include the „S“. 
After you entered the Shelf, its number will appear in the Shelf frame, until you enter a different Shelf.
2. Now you need to scan (or manually type) the ISBN of your book. You do that in the „Shelf/ISBN“ field. The program does not allow you to enter mistyped ISBNs, and moves the focus and selection back to the „Shelf/ISBN“ field. If you entered it correctly, the focus moves to the next available field, where you can manually enter the rest of data. After you have entered the price (and if all the previous data is typed correctly), the item is added to records.
3. In cases where you load the same quantity of different items, which have same condition, you can check the „Use Default Quantity“ and/or „Use Deafult Condition“ boxes to tell the program to use the information from the Preferences window.
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4. In the above window, you can use the SKU Prefix and Intitial SKU Serial # to instruct the program how to generate the SKU when you add your items by using Scanner Loader. Every item in Repricer needs to have its own SKU, so this is where you set the rule how the SKUs get generated.
When importing listings from a file, the program generates random SKUs for any of the listings without the SKU, and uses the SKU Prefix from the Preferences window (if specified), but not the Initial SKU Serial #.
5. When not using „Use Default Condition“, you need to enter the condition of the book manually. However, you don't use letters, but a number. The number correspond with Amazon's definitions that apply for the Inventory Loader files and all Amazon's reports available to sellers.
1 = Used; Like New 

2 = Used; Very Good 

3 = Used; Good 

4 = Used; Acceptable 

5 = Collectible; Like New 

6 = Collectible; Very Good 

7 = Collectible; Good 

8 = Collectible; Acceptable 

9 = Used; Refurbished (for Electronics and Camera & Photo only) 
10 = Refurbished (for Computers, Kitchen & Housewares, Electronics, and Camera & Photo only) 
11 = New
EDITING

When you need to edit a record, just double click on it, and the following window will open. After you have made your changes, press OK for the program to accept it and close the window.
If you want to edit more items at the same time, select the records, then above them click the right mouse button , and then click „Batch edit...“. The same window will open, but the changes will get blue colored, and they will apply to all the selected records after you press OK.
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